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					PDFill 14.0 
                    or earlier registered users are FREE to upgrade to 15.0 
					Professional! Just 
                    uninstall the older version and install the newer one! If 
					you have technical problem, please report to
					support.

                    Here are the new functions added to PDFill 
					15.0 (Build 3) 

					(Updated Feb 6, 
                    2022)

                    
                      
                        
					
					Download 
					PDFill 
					PDF Editor  
					15.0 (32Bit/64Bit) 
					for XP/2003/2008/Vista/Win7/Win8/Win8.1/Win10

					Also Support XP/Win7/Win8/Win8.1/Win10 Tablet

                      

                    

		

		Build 3:  
		A few bugs fixed

		        
		   Shortcut Changes: Thumbnail/Ctrl+M,  
		Edit the Shape Text/Ctrl+T

            
		If 
		Shortcuts Stop working, Use View Menu => Reset all Toolbars to the 
		default values

		 

		
                    PDFill PDF Editor Enterprise 15.0 

		Build 2:

		
			Office Shape:
			Recently Used 
			Shapes, 
				Lines,
				Rectangles,
				Basic Shapes,
				Block Arrows,
				Equation 
			Shapes, 
				Flowchart,
				Stars and Banners,
				Callouts,
				Action Buttons

			
			Custom 
			Shapes

			
			Fill Mode for Group Object

		

		

		
                    PDFill PDF Editor Professional 15.0 

		Build 2:

		
			A few bugs fixed.

			Callout: A Grouped 
			Object with a Multiple Line Text with Arrow. The Arrow can be edited 
			as a curve. 

			
			
			Rectangle Shape: 

   Corner Option: All/Left-Top/Left-Bottom/Right-Bottom/Right-Top 

   Shape Option: None/Round/Snip/Round In,

   Radius: For each corner

			
			Circle Shape:
			

    Full Circle,  Arc, Pie, Chord, Full Teardrop 

			OCR: 

    Support PDF and Image Input with Page DPI

    Text Layer Only PDF

    DOS Command: Searchable PDF, Text Layer Only PDF, HOCR File, 
			TSV File

			 

		


		
                    PDFill PDF Editor Professional 14.0 

		Build 2:

		
			A few bug fixed.

			PDFill 
			
			Save the PDFill Objects: Folder Option, Add Before Option; 
			Selected Saving object moving along with the mouse.

			Edit Menu => 
			Take a 
			Snapshot: Copy Part of PDF Page into Clipboard

			PDFill Options => General =>Snapshot DPI: Default is 150 dpi

			Insert Menu => Check Box Menu => Cross, Tick, 
			Radio and Dot 

			New Option for
			Export and 
			Import Form Data:  UseRow and SheetName

			Dos Command for Barcode: Add options for Rotation, 
			Background Color and Position 

			Dos Command for Merge: -bookmark 
			1

			Dos Command for Export or Import using Excel: 
				-UseRow 
				1 
				
			-Append "12" -SheetName "Sheet2"

		

		Build 1:

		
			Uninstall the older PDFill products during the new 
			installation.

			Save Option inside Watermark by Text.

			Change 
			Case inside Text Editor: 
			lower case, UPPER CASE, Capitalize Each Word, tOGGLE cASE, Sentence 
			case.

			Open New PDF or PFL with All File Types.

			Export PDF as Text File or Image File from File 
			Menu => Export

			Color Pick function for Font Color, Ink Color, 
			Line and Fill Color; 

			Remove some icons from Standard Toolbar; 

			Allow the same file name to be saved.

			Add PDFill's own Print function.

			Allow the redacted object Copied across pages 

			Align the PDFill objects Horizontally or Vertically of the Page 
			Center

			Add an option to deactivate the license during the uninstall. 

			Single Line Text is converted into Multiple Line 
			Text When "ENTER" Key is typed. 

			Toolbar to remove the icons: PDFill Options 
			=>View: Select a Toolbar => Select to Hide or Show the icons 

			Insert invisible text to make it searchable: 
			Single Line Text, Multiple Line Text, Watermark By Text => Stroke 
			Type => Type of Striking: Fill, Strike, Fill and Strike,
			Invisible and Searchable

			PDF Form Maker to create JavaScript Code 
			automatically

				Format: Number with Decimal Places, Separator Style, Negative 
				Number Style, Currency Symbol;  Percentage with Decimal Places, Separator Style;
				24 Date Options; 
				4 Time Options; Special with Zip Code, Zip Code + 4, phone Number, Social 
				Security Number, Arbitrary Mask
	
			Validate => Select an Example => 0<N<100; 
			0<=N<=100;  Read only and Grayed out

	Calculate => Select an Example => 
				Average, Sum, Product, Minimum, Maximum, Custom


		

		
			Document Menu => FREE OCR to convert Image into searchable PDF

			Document Menu => Operations on Pages 
			(Insert, Extract, Replace, Rotate, Crop...) => Rotate Page 
			Clockwise / Rotate Page Counter Clockwise

			Document Menu => 
			
									FREE
									PDF Optimizer

			Document Menu => 
			
									FREE
									Extract Text 
									and
									Image

			Select Original Texts:

				Highlight 
			Original Text (FREE Comment)
	Strikethrough Original Text (FREE Comment)
	Underline Original Text (FREE Comment)
	Squiggly Original Text (FREE Comment)
	Add Note To Replace Text (FREE Comment)
	Add Note to Text (FREE Comment)
	Create Link (Comment)
	Add Bookmark
	Search Google for (FREE)
	Copy Original Text to Clipboard (FREE)
	Delete Selected Objects
	Replace with a Single Line Text
	Select All, Deselect, Exit Selection.


			Select Original Images: 
									

				
				Copy Image to Clipboard 
				(FREE)

	
				Extract Image to 
									File (FREE)

	
				
				Replace with a 
				new Image 

	
				
				Delete

				
	
				Deselect, Exit Selection

				


			Make Original 
			Comment Editable:  

				
				Right Click 
				Menu to the Original Object with Options: Current Object's 
				Properties, Delete Current Object, Edit Current Original 
				Comment;

	
				Edit Menu => 
				Make Original Comment Editable => Current Original Object, Edit 
				Entire Original Comments, Select Original Comment by Click or 
				Drag, Delete Original Comments Only, Delete All Original 
				Comments;

	
				From the 
				Property of Original Comment: add a button to Make Original 
				Object Editable



			Overlay a PDF Page Like an Image:

				
				Insert Menu 
				=>Image or PDF Page => Insert PDF Page Like Image

				
	
				Add Watermark by 
				a PDF Page on PDF Pages

	
				DOS Command to 
				Add Watermark by a PDF page 



			
				Image Object, Watermark by Image:  
			Add Frame Line and Fill Color

			

			Add new 
								PDF Batch 
						Commands:

			
				
				
				PDF Optimizer

				PDFill.exe
			Optimizer Input.pdf Output.pdf flagSettings 
			Resolution MaxInlineImage  AutoRotatePage ColorModel 
			CompressFont

				
				
				Extracting 
				text inside PDF from the selected pages

				PDFill.exe
			ExtractText 
			Input.pdf Output.txt 
			TextOption1to7 UnicodeTextFortmat OutputPageSeparately -SelectPages 
			"1-2" -HeaderText  "Test<<Page 1 of n>>"

				
				
				Extracting 
				Image inside PDF document from the selected pages.

				PDFill.exe
			 ExtractImage Input.pdf Output.bmp 
			-SelectPages "1-2"

				
				OCR function converts 
				Image into searchable PDF 
				

				PDFill.exe
			OCR Input.BMP Output.PDF

			

		

		

		
                    PDFill PDF Tools 14.0 

                            	
                                    
                                        Free PDF Tools 
									1: Merge Multiple PDF files into one file

										Add Bookmark using File Name 
									(Professional User Only)

									Total Pages

 
	
                                    
									Free PDF Tools 
									5: Reformat PDF 

									Fix a bug inside Reformat 
										as Page Rotation of  180, 270 

 
	
                                        
										Free PDF
										
										
										Tools 7: Add PDF 
										Watermark by Text

										Save Option as a Name (Professional User 
										Only)

 
	
                                        Free PDF Tools 9: 
										Convert Images to PDF:

										Use Image Compress (Professional User 
									Only)

 


		PDFill PDF Writer 14.0
		

			Update the
			PDFill 
			PDF Button for Office 2013 or later
 
	Remember the last selection of Post Process 
			options


		

		
                    PDFill PDF Editor 13.0 

		Build 6:

		
			Highlight Comment: Add Style (Rectangle, 
			Oval, Round, Cross-out, Underline, Squiggly) 

			New Link Comment

			Comment Drawing 
			Tools: Line, Arrow, Rectangle, Oval, Polygon, Cloud, Connected 
			Lines

			DOS Command 
			supports Barcode Generator for PDF Page

			DOS Command 
			supports Input File Folder and Output File Folder (Encrypt, Decrypt, Crop, 
			Rotate, Reformat,  Header and Footer, Watermark by Text, 
			Watermark by Image, Barcode)

			Dos Command => Header or 
		Footer =>Support Multiple Lines, Date Format, and Bates Number 
			<<Bates#6#Offset#100>> 

			Make Original 
			Comment Editable:  

				
				Right Click 
				Menu to the Original Object with Options: Current Object's 
				Properties, Delete Current Object, Edit Current Original 
				Comment;

	
				Edit Menu => 
				Make Original Comment Editable => Current Original Object, Edit 
				Entire Original Comments, Select Original Comment by Click or 
				Drag, Delete Original Comments Only, Delete All Original 
				Comments;

	
				From the 
				Property of Original Comment: add a button to Make Original 
				Object Editable



			Lock/Unlock 
			Objects:

				
				Edit Menu => 
				Align Tools => Group or Lock Objects => Lock the Selected 
				Object, Unlock all the Objects;

	
				Right Click 
				Menu => Lock the Selected Object



		

		 Build 5:

		
			Add Head, Foot and  
			

			Use Bates Number as the New File Name

			Combo/List Form Field Multiple Line

			DOS Command for Rotation/Crop: Landscape and Portrait

			Fix A bug for "Select to Edit" Under Right Click Menu

			File Menu => New Blank Page =>Insert Multiple Blank Pages

			Fix a bug for GIF compression

			Search Text Function: PDFill Objects and Original Text

			Select Original Images: Copy Image to 
			Clipboard, Extract Image to File, Replace with a new Image, Delete, 
			Deselect, Exit Selection

		

		Build 4:

		
			Require Microsoft .NET Framework 4 from 2.0

			Fix a Bug in Deskew and 
		add DPI Option for Deskew Page

			Fix a Bug in the Open PDF 
		File

			Fix a Bug of "Parameter is incorrect"

			Show the original Push Button and  
		Signature Form Field for deletion and editing

			PDF Redaction => Delete Original Image Only: Select part 
			of Image

			PDF Redaction => Delete Original Text Only: Select part 
			of a sentence

			PDF Redaction => Delete All Original Contents: 
			Image, Text, Shape, Comment and Form Field 

			PDF Redaction => Delete 
				All Original 
				PDF Comments

		

		Build 3:

			PDF Redaction/ PDF Eraser 
			=>To Delete  
		the original text/Shapes/image


		
			
				Use Redaction / Eraser Color;

				Delete Original Image Only: Extract Image, 
				Replace with a new Image;

				Delete Original Text Only: Copy Text to 
				Clipboard; Replace with a Single Line Text;

				Delete Original Shape Only;

				Delete Original Text and Shape;

				Delete Original 
				PDF Comment; 

			

		

			
			PDFill  
			Group/Ungroup Objects to 
			group texts, shapes, and pictures

 

	
			PDFill 
			
			Save, Manage and Use the PDFill Objects

 

	
			PDFill
			PDF Barcode 
		Generator

			
				
				QR Code,
				Data Matrix,
				PDF 417,
				POSTNET or PLANET Barcode,
				CODABAR Barcode,
				Code 39 and Code 39 Extended Barcode,
				Interleaved 2 of 5 Barcode,
				EAN/UPC Barcode,
				EAN/UPC with Supplement Barcode,
				Code 128 Barcode

				

				Options: Rotation, Scale, Saving Barcode Image (PDFill Options => 
		System=>Barcode DPI 150)

			

			
	
			Add Arrow Heads
			for Curve Drawings



			
			Document Menu => Select a file 
		to Extract the original images
			 

 

	
			Rotate Option using Combo Box for 
		Single Line /Multiple Line Text /Image /Shapes /Curves /Stamps

			
	
			SINGLE LINE TEXT 
		Char Space 

	
			Option to show/hide 
			the Ruler

 

	
			Redesign
			PDF Document 
			Management Menu and Toolbar:



		
			
				Document Menu 
				=>More Operations on Pages => Insert Pages, Extract Pages, 
				Replace Pages, Rotate Pages, Crop Pages, Crop Page Visually, Page Actions

				
				New Function: 
				Crop Page Visually by Mouse Dragging 

			

		

			
			Hold SHIFT Key to 
			draw Horizontal, Vertical or 45 degree straight lines for Drawing
			Line or Arrow Tool, Drawing
			Curve Tool, Comment
			Line or Arrow Tool, Comment
			Polyline and Polygon Tool.
			

 



			Text Run Direction and Arabic Options for
			
			Single Line and
			
			Multiple Line Text Tools


		
			
			Text Run Direction: Default Run 
				Direction; No Bidirectional Reordering; Left To Right (LTR); 
				Right To Left (RTL).

			
			Arabic Shaping: None; Eliminate 
				Vowels; Compose Tashkeel; Extra Double Ligatures. 
			

		

			Image Insert 4 Options: Signature 
		Image from File; Image from File; Image from Clipboard; Image from 
		Scanner; Image from Saved Images


			
			
			Add Image 
			Processing for Image Object: Make It Transparent, Rotate Right 90, Rotate Left 
			90, Rotate 180, Flip Vertical, Flip Horizontal, Invert Color, Make 
			it Gray, Make it Black/White, Scale 75%/50%/25%

 

	
			
			PDFill Options => Default 
			=> PDFill Type 
		Start With: Selection, SingleLine Text,
		MultipleLine Text,
		Check Box, Image, 
		Line, Arrow, 
		Curve, Ink Pen, 
		Ink Marker, Ink Highlighter
PDFill Options => Default 
			=> Font 
		Property Selection: Font Encode, 
		Font Name, Font 
		Style, Font Align, 
		Font Size, Font Color
PDFill Options => Default 
			=>  Drawing 
		Property Selection: 
		Line Size, Line 
		Color, Dashed 
		Style, Arrow Begin 
		Style, Arrow End 
		Style, Arrow Begin 
		Size, Arrow End 
		Size
PDFill Options => 
			View => Choose GUI Style =>NO Action, Default GUI (Reset All 
			Toolbars), GUI for Sketchers



			
			PDFill
			License 
			Activate and Deactivate



		
			
				For each license, you can only 
activate on two different 
				machines. Choose 
				Help Menu => Enter Registration Code => Activate.

				

				To install the software on a different computer, you must first deactivate the 
license on your current computer. Choose Help Menu => 
				Enter Registration Code => Deactivate.

				

				Show Evaluation Dialog if not 
				activated. Option to hide this dialog.

			

		

		

		

		PDFill PDF Editor 12.0

			
								
								
								
								PDFill PDF 3D to convert U3D Model into PDF 
								3D format so that the end user can 
								view/rotate/zoom/section 3D Model inside free 
								Adobe Reader.
 

	
								
								
								
								PDF Form 
		Field Recognition by Clicking: Text Field over a 
								line;
								Text Field inside a Box;
								Text Field with Combo Chars by inside a Box;
								Check box inside a Box;
								Radio Button by inside a Box.

 

								
	
								
								
								
								PDF Barcode: QR Code, Datamatrix, PDF417
 

								
	
			
			
			Push Button Form Field: New options for Label and Icon Layout, Add image 
			as Icon, Scale Option.
			You can 
			create a button form field to insert a PDF file with Adobe Reader 
			XI. If you want to insert image, you can use
			Free PDF 
			Tool to convert image into PDF.

 

	
			
			Add a
			New
			
			Digital Signature Form Field.

 

	
			Redesign the 
			Right Click 
		Menus: Add Option to Show Page Grid, Form Field Name, Tab Order. 

 

	
			Redesign the 
			Cut/Copy/Paste functions.
			

 

	
			Multiple Object Copy for all inserted 
		PDFill Objects.

	
			Duplicate the object across the pages.

 

	
								Ink State is kept after page navigation.
 

								
	
								Add a function to Show/Hide Grid Lines.
 

								
	
								
								Extract PDF into Text with options.

								


                            	
								
								Update Code Signing Certificate.

 

								
	
								
								PDF Dates to remove 6 digit limit 
								as appear inside Adobe Acrobat
 

								
	
								
								
								PDFill Options=>System=>Add Option to read 
										pages.
 

	
								
								
								Fix a bug in 
								Document=>Insert Pages and Replace Page.
 

								
	
								
								
								PDF Link & PDF 
								Action: Submit Entire PDF by Email: 
								Email To, CC, BCC, Title, and Body Text.
 

								
	
								
								
								AutoFill List: 
								Inside Text Editor, Right Click => Save this Text 
								into AutoFill List or Select a Text from 
								AutoFill List.
 

	
								
								
								PDF Saving 
								Option => 
								Advanced Tab.

Print Dialog Presets: Page Scaling, DuplexMode, 
								Paper Source by Page Size, Print Page Range, 
								Number of Copies
PDF Settings: Base URL, Trapped 
								
Reading Options: Binding, Language
 

								
	
								
								
								PDFill Options=>System=>Script 
										Text File for Batch Error Message
 

								
	
								
								
								
								PDFill 
								Options 
								=> Form=> Add Option to show the 
								Hidden Original Form Field; Add Option to Edit 
								the Read-Only Original Form Field; Add Option to 
								Show/Hide New Text Form Field's Property Dialog 
								
 

	
								
								
								
								PDF Optimizer: 
					Document Menu => PDF 
								Optimizer: Create PDF files 
								optimized for Screen, Ebook (online uses), 
								Printer, Prepress (high resolution and embedded 
								fonts) or Default (wide variety of uses). 
 

								
	
								
								
								Page Numbering: Add 
							new Key Words: all, last. ( even, odd, reverse).
 

								
	
								
								
								Document Menu => 
								Extract Pages using File Size (1.50MB) or Top 
								Level Bookmark

	
								
								
								Document Menu => 
								Extract Phttps://www.pdfill.com/document_pages_extract.htmlages (Select a PDF File) using Pages, File Size 
								(1.50MB) or Top Level Bookmark
 

								
	
								
								
								Add new 
								PDF Batch 
						Commands:



		
			
			Add Page Option to Rotate 
			and Crop PDF Pages:

			-page "1,3-6, last"

			
			Add Page Not Shown Options 
			to Header or 
		Footer, Watermark by 
		Text and Watermark Image:

			-pageNotShown  "1,3-6, last"

			
			Flatten a PDF 
			form
"C:\Program Files\PlotSoft\PDFill\PDFill.exe" Flatten 
			Input.pdf Output.pdf

			
			
			Extract a PDF 
			into a serial of pages 
			using Top Level Bookmark
"C:\Program Files\PlotSoft\PDFill\PDFill.exe"
			EXTRACT 
			BOOKMARK Input.pdf Output.pdf 

			
			
			Extract a PDF 
			into a serial of pages 
			using File Size
"C:\Program Files\PlotSoft\PDFill\PDFill.exe"
			EXTRACT 1.50MB Input.pdf Output.pdf

			

			Delete PDF Pages selected into a new PDF

			"C:\Program Files\PlotSoft\PDFill\PDFill.exe" DELETE 
			"1,3-6,10,13,24,last,4-last,even" Input.pdf Output.pdf 

 

		

		

		
                    PDFill PDF Tools 12.0 

                            	
                                    
                                        Free 
                      PDF Tools 14 - Free Scanner (Scan to Image or Scan to PDF):

										Make WIA method 
                                        as the default method.

										Add an option to overwrite the existing 
										file. If unset, the file name will be 
										increased by 1 automatically.
 

                                
	
                                    
                                        Free PDF Tools 2: Split, Reorder or 
										Delete PDF Pages:

										Add "last" Tag as the last page.
 

                                
	
                                    
                                        Free PDF Tools 9: 
										Convert Images to PDF:

										Add a function to Use Image Size to 
										decide Page Size with DPI

 

                                
	
                                    
                                    Add View => Toolbar's Icon Size 
									=> 16 x 16 point, 24 x 24 point and 32 x 32 
									point

 

                                



		
                    PDFill PDF Writer 12.0 

                            	
                                    Add View => Toolbar's Icon Size 
									=> 16 x 16 point, 24 x 24 point and 32 x 32 
									point
	
                                    
									
									PDFill PDF Button for Office 2013 


		

                            
                    PDFill PDF Editor 11.0 

			
					
					No Need for Java and 
					Microsoft .Net 2.0 is required..


				
	
					
					Add Thumbnail View from 
						View Menu and View Toolbar to display a preview of the 
						pages:
To select a single page, click the left mouse button 
						inside a page; 
To unselect all selected pages, click the left mouse 
						button outside a page;
To select multiple pages, hold the left mouse button to 
						draw a box outside the pages;
To select or unselect one by one, hold "Ctrl" key 
						and click the left mouse button inside page;
To select or unselect in a range of pages, hold "Shift" 
						key and click the left mouse button inside page;
Right click inside a page to Delete , Extract and 
						Replace the selected pages;
Right click between pages to Move selected Pages, Insert 
						Blank Page, Insert New Pages from another PDF;
Right click to Reduce or Enlarge Page Thumbnails, Select 
						or Unselect a Page;
Rearrange pages by Drag and Drop the thumbnail images. A 
						box flashes between pages to indicate position.


				
	
					
					View Toolbar: Add two 
						buttons of Page Up/Page 
						Down.


				
	
					
					PDFill Options=>Tablet 
						Tab: When Tablet Mode is used, Tabbed Toolbar and Bigger 
						Icon size are set as default.


				
	
					
					Warning of Blurry Image if 
						Page DPI is less than 60.


				
	
					
					Document Management/Crop PDF Page: Add Spin Control for 
						the margin of Left, Right, Top and Bottom. 


				
	
					
					Redesign the way to add 
						Combo/List Form Field' Item and Export values. 
					


				
	
					
					Automatic Tab Order
						feature: 
PDF Form 
		Fields => Set Tab Order => New Tab Order Automatically: 
The 
					current page's tab order will be calculated according to the center of new added objects from Top to 
						Bottom and from Left to Right. 


				
	
					
					Add Interleaving Options to interleave 
		PDF Page: Document Menu/Insert Pages/Interleave Options


				
	
					
					PDF Bates Numbering: 
					Document Menu/Bates Numbering


				
	
					
					Add Reset and Cancel 
					Buttons for Document Menu/Header and Footer


				
	
					
					Add "Inherit 
					Zoom" for Bookmark:

					PDF Document Management=>PDF Bookmark=>Fit by Point and Zoom=>Click 
					Button "Inherit Zoom" 

					PDF Document Management=>PDF Bookmark=>Select an Option 
					"Inherit Zoom" 
					


				
	
					
					Deskew PDF Page (Build 3): 
					Document Menu=>Page Deskew: Select Pages to Deskew; Draw a 
					line to Deskew; Deskew Page Automatically. The deskewed page 
					can be rotated, moved, scaled like an image.


				
	
					
					PDF Layer (Build 3):  
					View Menu=>PDF Layers. You can add and delete a layer. You 
					can set a layer's properties: New Layer after or under; 
					Layer Name; Group Title Only; Show or Hide Layer; Show Layer 
					On Panel; Locked; Initial State of Visibility, Print or 
					Export; Set Zoom Factor of Min and Max; Belong to a Radio 
					Button Group; Set or Clear the default layer.


				


		

		
                    PDFill PDF Editor 10.0: 
					 Support Win 8 and Tablet 
					PC, PDF Ink Annotator, Undo/Redo, Saved Stamps, PDF Initial 
					View Options, Tabbed Toolbars and Bigger Icon Size, 12 Blend 
					Modes, WIA Scanning, Batch Commands, Move PDF Pages and 
					more&

						
						
						
						Stamp: Save as a name and 
						use the saved stamps later.
 

	
						
						
						Undo PDFill Objects: Undo the 
						last action or actions that you made.

						Redo PDFill Objects: Redo actions that you undid.

						


						
						
						PDF 
						Ink Annotator: Pen/Marker/Highlighter, 
						Selection/Deletion, Undo/Redo, Ink Color/Width, 
						Pressure-Sensitive Pen, Auto Smooth Free Hand to 
						Straight lines, Set Ink's Default Properties.

						
	
						
						Support Windows 8. 
 

	
						
						Support Windows Tablet 
						(XP, Win7, Win8). 
From PDFill Options, select "Tablet":
Select "Use Tablet Mode";
						Select "Selection Diameter" to 24 pixels;
						Show Cursor inside Selection Circle
 

						
	
						
						PDFill Options, select 
						"View" Tab:
Choose Toolbar's Icon Size: 16 x 16, 24 x 24 or 32 x 32 
						point.
Choose to use "Tab Toolbar Mode": All toolbars will be 
						put under a Tab View.
Add Options to Hide each Toolbar.

						


						
						
						Redesign the Initial View 
						of PDF Saving Option:  
Page Layout, Navigation Tab, Exit Full-Screen, 
						Magnification, Open to Page, Show Document Title, Resize 
						window, Center Window, Hide Menu Bar, Hide Tool bars, 
						Hide Window Controls. 

 

	
						
						Add a Document Toolbar.
 

	
						
						Add a button in the Dialog 
						of AutoFill List for PDF Form Fields: Import name/value from current filled 
						PDF form fields.
 

	
						
						Check the field name of 
						the new Form Field to 
						make sure that they are the same field type.
 

						
	
						
						New Text Field's 
						Properties: Combo of Max Characters to spread the 
						user-entered text evenly across the width of the text 
						field.
 

	
						
						PDF Comment/Stamp Tool 
						works on the rotated PDF.
 

	
						
						PDF Comment/Highlight: New 
						Design to use 
						Transparency 0 and Multiply Blend Mode
 

						
	
						
						PDF Filler/Highlight: New 
						Design to use 
						Transparency 0 and Multiply Blend Mode
 

						
	
						
						Add Keystrokes for Document 
						functions.

	
						
						Reverse for Page 
						Renumbering
 

	
						
						Dynamic Stamps: 
Add Option to not have the filling color.
Add Option to use the date and user name when the PDF is opened. 
						
Copy this stamp Object to all the pages
 

						
	
						
						Add 12 Blend Modes:
						Normal, 
						Multiply, Screen, Overlay, Darken, Lighten, ColorDodge, 
						ColorBurn, HardLight, SoftLight, Difference, Exclusion.
 

						
	
						
						Image Stamp:
						Add 12 Blend Modes; Overall Transparency; Make it 
						Transparent
 

	
						
						SingleLine/MultipleLine 
						Text,  Check, Line, Arrow, Rectangle/Circle, Basic 
						Shapes and Curve: Add 12 Blend Modes.
 

						
	
						
						Image Object: Add 12 Blend Modes and 
						Overall Transparency.
 

	
						
						Watermark by Text: Add 12 
						Blend Modes. More default rotating degrees.
 

						
	
						
						Watermark by Image: Add 12 
						Blend Modes; Overall Transparency; More default rotating 
						degrees.
 

	
						
						The Opacity for all 
						comment and stamp Objects: Using Slider bar for 
						convenience instead of Text Box input.
 

						
	
						
						Add a function to Move pages to a new Location
						
Document=>Page 
						Renumbering => Move the selected Pages Before or After 
						new Page Location



						
						
						Fixed the color 
						shading problem for the transparent objects.  
						

 

	
						
						The performance of drawing 
						image is increased greatly. 
 

	
						Add an option for the 
						Single Color Selection Tolerance so that the colors that 
						are close to the selected color can also be selected;
PDFill PDF Filler : Image Tool 
						=>Make it Transparent

						Document 
						Menu => Add PDF Watermark by Image => Make it 
						Transparent
 
	Add function to 
						support the Comment (Line, Polyline, Cloud or Curve) on 
						the rotated PDF pages.

 
	Add Default Zoom 
						Selection (Fit in Window, Actual Size, Fit in Width)

 
	Add option to scan 
						using WIA instead of TWAIN method so that Both TWAIN and WIA are supported.
 
	Check box/Radio Button 
						Form Field: Make Square as the default

						Right Click Menu

						Form Field: Use Default Whiteout Color as the Fill Color

 
	Add new 
						PDF Batch 
						Commands:

						Merge all PDFs 
						under a folder into a new PDF
Extract a PDF into a serial of single or
						multiple pages

						Encrypt or Decrypt a PDF

						Rotate or Crop PDF Pages

						Reformat PDF Pages

						Add Header or Footer on PDF Pages

						Add Watermark by Text on PDF Pages

						Add Watermark by Image on PDF Pages

						Convert Images to PDF

						Convert PDF into Image

						Export and Import Metadata Information 
						


					PDFill FREE PDF Tools 10.0:
					
					

					
							
							Fix the crash 
							problem on a very few computer when a PDF file is 
							selected.


							
							
							
							Free 
						PDF Tools 1 - 
							
							
							Merge Multiple PDF files into one file:

							Add an option to select 
						all the PDF files under a folder.

 

	
							
							Free
            PDF Tools 2: Split, Reorder or Delete PDF Pages 

							Add Reverse for Reorder PDF Pages
 
	
							
							
							Free PDF Tools 4: Rotate and Crop PDF Pages 

							Redesign the interface
 
	
							Free 
        PDF Tools 9: Convert Images 
        to PDF

							Add all Images under a Folder


							
							
							
							Free 
                      PDF Tools 10 - 
							Convert PDF to images:

							Add a File Save as 
						Dialog
 

	
							
							
							Free 
                      PDF Tools 14 - 
							Free Scanner (Scan to Image or Scan to PDF):

							Add an option to choose 
						TWAIN or WIA method so that Both TWAIN and 
						WIA are supported.



						
								
								
								
								Free PDF Tools 15: Create Transparent Image:

								Add an option for the 
						Single Color Selection Tolerance so that the colors that 
						are

 

	
								
								
								Add View 
								Menu: Menu Style, Units, System Information, 
								Reset all Parameters, Windows (Places 
								this Dialog above all other windows, Show Max 
								Icon, Show Scroll Bar, 480 x 360, 640 x 480, 800 
								x 600)




					

					
					PDFill FREE PDF Writer 10.0:
					

					
							
							
							Add a BUSY flag 
							when it is converting PS to PDF

	
							
							Add Time Stamp 
							(Year, Month, Day, Hour, Minute, Second) to the file 
							name.



					

                    

					
                     

                    
                    PDFill PDF Editor 9.0:

                    	Fix a bug related 
						"xmp:ModifyDate 
						not bound" or "Invalid Characters" error.
						

 
	New function "PDF 
						Object Remover" is added to remove 
						original PDF Objects (Text, Image, Drawing and 
						Annotation). This is still in Beta Stage.
 
	The digital signature is updated on Jan 24, 2011.

 
	New function to copy the email with the code section and 
						paste into
						
						registration form automatically.
 
	New Zoom Functions: 
						
						
							
								
									Marquee 
									Zoom Tool:  Drag a rectangle around a 
									portion of the page to zoom into this area 
									Or Click to increase the magnification.

									Dynamic 
									Zoom Tool:  zoom in when you drag it up 
									the page and zoom out when you drag down.
									
 



						
	PDFill Options:  
						Resume Last project on Opening, Warning to save Project File in 
						Minutes. 
 
	The new installation EXE doesn't require 
						"Right Click 
						to Run as Administrator". 
Add option to Create PDF Button inside Microsoft Word, 
						PowerPoint and Excel.
Add option to Create PDFill Button into Microsoft 
						Internet Explorer.
Add option to Create PDFill Button into Quick Launch and 
						SentTo.
 
	PDF Form Maker:  Add the default value for 
						Combo/List Form Field, Add multiple selection for List 
						Form Field; 
	PDF Form Filler: Fix a few bugs for Combo/List Form 
						Field.


                    	Removes the usage rights that PDF may have. 
						


						The blurred bug for the scanned image is fixed.
 
	Add 
						Polyline and Polygon Comment 
						Tool.
 
	Add 
						Cloud Comment 
						Tool.
 
	Add 
						Cloud Option to
						Commenting Text Box. Change Comment Border Style in the Adobe way and also 
						with custom input.
 
	Add a function to Insert Image from Clipboard.
 
	The 
						comments created by PDFill can be read into PDFill. 
 
	Add a function to Summary of Comments into a text file.
 
	Add a new 
						Comment Stamp 
						Type: 
Sign Here Stamps:

						Witness, Initial Here, Sign Here, 
		Accepted and Rejected.

Standard Business Stamps:
Approved, Not Approved, Draft, 
		Final, Completed, Confidential,  For Public Release, Not 
		For Public Release, For Comment, Void, Preliminary Results, and 
		Information Only. 

Dynamic Stamps:
Revised, Reviewed, Received, Approved, Confidential and Custom Text 
		Stamp.

Image Stamps:
Image from File or from Clipboard 
						
 
	Document=>Page Extraction:  Add an option to extract 
						multiple pages instead of a single page as separate files.
 
	For the registered 
						user, the producer information can be changed.
 
	Fix a bug when reading 
						the project file under a web link.
 
	You 
						can read your bookmarks into PDFill for editing, import 
						a XML Text file into PDFill, export bookmarks into a XML 
						Text file and export the bookmark's title into a text 
						file. 
Two batch Commands for Bookmark are added:


					
						Import a XML Bookmark file into a PDF

						"C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    IMPORT BOOKMARK Input.xml Input.pdf Output.pdf

						Export PDF's Bookmark into a XML file
						
"C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    	EXPORT BOOKMARK Input.pdf Output.xml


						
						Redesign Import/Export with Microsoft Excel. Read from 
						or write into Excel's column name to allow multiple sets 
						of form data inside one Excel file. Use Column Name "B" 
						instead of "FORMDATA" for Batch Command:

						

						"C:\Program Files\PlotSoft\PDFill\PDFill.exe" IMPORT XLS
						B Input.xls Input.pdf Output.pdf 

						

						"C:\Program Files\PlotSoft\PDFill\PDFill.exe" IMPORT XLS
						B Input.xls Input.pdf Flatten Output.pdf    
            (to Flatten the Output.pdf)

						
//Output to Column B 
						

						"C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
            EXPORT Input.pdf B Output.XLS 

						

						//Append the field values to Column C

						"C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
            EXPORT Input.pdf APPEND C Output.XLS


					
						 PDFill FREE PDF Tools 9.0:
					
					
                    	
                      
                      Support 
						reading image as *.tiff and *.jpeg.

 

	
                      
                      Free 
                      PDF Tools 2 - PDF Page Split/Reorder/Delete:

                      Add an option to extract 
						multiple pages instead of a single page as separate files.

						Reverse for Page Renumbering



					 

						
                      
                      Free 
						PDF Tools 13 - 
                      For the 
						registered user, the producer information can be 
						changed.




					
					PDFill FREE PDF Writer 9.0:
					

					
							
							
							Add Option to 
							control the days to delete the tmp ps files.

	
							
							Add Option to 
							change java memory size for extra large PDF 
							creation.

	
							
							Fix the default 
							printer problem with PDFill FREE PDF Writer inside 
							Microsoft Word.

	
							
							Save As Dialog: You 
							can switch the File Type of PDF, PNG, JPG, BMP, GIF 
							and TIF.

	
							
							The flashing window 
							before the SaveAs Window is reduced.

	
							
							For the PDFill registered 
							user, the producer information can be changed.

	
							
							Add Option for the 
							existing PDF: Replace it with Warning, Replace it 
							with NO warning, Append or Prepend it.

	
							
							Fix a bug to support 
							GhostScript 9.01 64 Bit.



					

                    

                    
                    PDFill PDF Editor 8.0:

                    	One installation package to support both 32 Bit and 64 Bit 
						OS.
	Download and Install Java and GhostScript automatically; 
                      Support 64Bit Java; Java Web Start is not installed.
	PDFill PDF Editor doesn't require GhostScript although the 
                      free PDFill PDF Writer still needs it.  
	When 
                      PDFill opens a PDF file, the first page is immediately 
                      loaded into PDFill for editing while the other  pages are 
                      being read at the background.  
	Since the images file from PDF pages are saved into temp 
                      folder, the file size of the project file (PFL) is much 
                      smaller. 
	Add 
                      some delay when the new edited PDF is Open or Printed to 
                      avoid the problem of file not found. 
	Give 
                      a warning to adjust the page resolution when reading a 
                      page much bigger than the Letter.  
	Fix 
                      the crashing problem when the user sets PDFill as the 
                      default viewer although Adobe Reader is recommended. 
                      
	Fix 
                      the bug to read PDF with thousands of PDF Pages. 
                      
	Add 
                      dpi when reading big file on Page Selection. 
                      
	For 
                      Single Line or Multiple Line Text, add Stroke Color, 
                      Stroke Size and Stroke Type.  
	Add 
                      PDF 
                      Watermark by Text
	Add 
                      PDF 
                      Watermark by Image
	Display large image inside PDFill as 1.0M to speed up the 
                      drawing performance (the saved PDF still uses the large 
                      Image) 
	Fix 
                      a bug when the PDF inside Internet Explorer is loaded into 
                      PDFill.
	Add 
                      an option to change the most used properties for the 
                      selected multiple objects
	Add 
                      Pencil Tool Commenting
	Add 
                      a 
                      Document Menu: Move Bookmark, Watermark, Header&Footer 
                      into it
	Add 
                      New Functions under Document Menu: Delete, Reorder, Insert, Extract 
                      and Replace PDF Pages.
	Add 
                      New Functions under Document Menu: Pages' Rotation, Crop 
						and Action; Remove this function from PDF Save Options.
	Add
                      188 
                      Shapes for PDF Form Field: Check and Radio Button.
	Improve the Drawing of PDF Form Field's Border inside 
                      PDFill: Solid/Dash/Bevel/Inset/Underline.
	Save 
                      PDF Option: The new PDF Form can be flattened as well as 
                      the original form.
	New Curve functions: Curve Eraser; Signature editing; 
						Curve Sampling Milliseconds in PDFill Options. 
						
	Add 
                      New Functions under Document Menu: Attach Files, Add 
						JavaScripts for Document.
	Add Trigger Actions for PDF Action inside PDF Form 
						Field: Mouse Up/Down/Enter/Exit/Got Focus/Lost Focus; 
						Keystroke. 
	PDFill Options=>Use the most updated PDF Library.
	Add Form Data Submit by Email
	Redesign the Property Interface for new PDF Form Field 
						using Tab View like Adobe Acrobat.
	Add 4 PDF field state triggers: Keystroke, Format, 
						Validate and Calculate.
	Add Form Field Tools of Calculation Order and Redesign 
						the Create Multiple Copies of Fields.
	Add Digital Signature.
	Add PDFill Option=>Transparent Text Editor.
	Support the encrypted PDF that can be open inside Adobe 
						Reader.
	Fix 
                      a few minor bugs.


                    
                    PDFill FREE PDF Tools 8.0:
                    

                    	
                      
                      Free 
                      PDF Tools 1 - PDF Merge:

                      Fix the bug to read PDF 
                      with larger PDF Pages.

                      Add an option to sort the file name 

 

	
                      
                      Free 
                      PDF Tools 2 - PDF Page Split/Reorder/Delete:

                      Fix the bug to read PDF 
                      with thousands of PDF Pages.

                      Add an option to Delete PDF Pages.

                      Add an option to Keep Bookmarks.

                      Add an option to extract pages as separate files.

                      Add an option to save the other pages as a PDF file.

 

	
                      
                      
						Free PDF Tools 10 - Convert PDF to Images:
Add more image types: GIF, PCX, WMF, EMF.
Add an option of Quality factor for JPG Image.
Add an option to create a single TIFF file with multiple 
                      pages.
Add an option of Page Number Digits for image name.
Add an option for Color Bit: 1,  8, 24 for PNG, GIF, BMP, 
                      TIFF, PCX.



                    
                    
                    PDFill FREE PDF&Image Writer 
                    8.0:
                    

				    	
                    Fix some 
                    minor bugs.

                      
	
                    Add a PDF 
                    Button to save PDF inside Microsoft Word, PowerPoint and 
                    Excel.

                      


                      	

                    
                    PDFill PDF Editor 7.0:

                    	Support Windows 7 32/64 Bit. Support GhostScript 64 Bit.

 
	Add 
                      the function of Transparency to the object of 
                      SingleLine/MultiLine Text, Check, Image and all drawings.
                      

 
	Add 
                      Basic Shape Drawings:  Isosceles Triangle, Right 
                      Triangle, Diamond, Pentagon, Hexagon, Left Arrow, Right 
                      Arrow, Up Arrow, Down Arrow, 4-Point Star, 5-Point Star, 
                      6-Point Star, Rounded Rectangular Callout, Oval Callout, 
                      Cloud Callout, Heart, Lightning, Smiley Face. 

 
	Add 
                      Curve drawing: Smooth Curve, Straight Curve, 
                    Smooth Scribble, Straight Scribble, Smooth Freeform, 
                    Straight Freeform, and Cloud Tool, with the function to edit each point and 
                      open/close the curve.

 
	Add the Signature Pen  Drawing so that you 
                      can sign up your PDF by computer.

 
	Multiple Selection by Dragging (From Left to Right or from 
                      Right to Left)  to move or Copy; Copy objects across 
                      the projects; Allow 
                    to Copy Image Object using the same image object; Copy 
                      object from one page to another page across the projects.

 
	Make 
                      the File Dialog Window (Open/Save) Resizable; 
	Middle Mouse Wheel to control page navigation; 
	Reset all the toolbar settings; 

 
	Fix 
                      a bug in the Downloading Automation of GS and Java on 
                      Vista and Win7.
	Fix 
                      a bug in ADF Scanner
	New 
                      Icon Design

 
	Batch Command for Export a PDF Form into FDF, CSV, Text/Excel 
                      (Tab-delimited)

 
	PDFill System Option: Large Image Display Reduction Cap to 
                      display image-intensive pages

 
	PDFill Edit Menu=>Copy PDF form Fields from another PDF.

 
	
                      Automatic PDF Repair by PDFill PDF Writer.

 
	Remove the Skip Options in PDF Saving Options.

 
	PDFill Options: Add the default receiver's name and Email; 
                      PDF name on Subject or Body Text.

 
	Add 
                      PDF Header and Footer


                    
                    
                    PDFill FREE PDF Tools 7.0:
                    

				    	
                    
		New Free Tools 13: Add information 
        (Title, Author,  Subject, Keywords, Created, Creator, Producer and 
        Version) to the PDF document.

                      
	
                    
                    New Free Tools 14: Scan your Paper Form 
        or Photo into images (PNG, JPG, BMP, TIF and GIF) or PDF

                      
	
                    
                    New Free Tools 15: Create a transparent image with options to adjust one Color and 
        the left Colors' transparency.

                      
	
                    
                    PDF Header and Footer: Add a Page Offset 
                    function.

                      
	
                    
                    Support Multiple  Page Tiff 
                    file

                      
	
                    
                    PDF Split: Add "Odd" and 
                    "Even" Pages

                      


                    
                    
                    PDFill FREE PDF&Image Writer 7.0:
                    

				    	
                    Make the 
                    Simplest GUI as the default: Keep it Simple

                      
	
                    Add System 
                    Information about GhostScript, Java and Adobe Reader

                      
	
                    Fix a bug 
                    when the new PDF is launched.

                      
	
                    Fix a bug 
                    when the new PDF is saved.

                      
	
                    Add a Tip 
                    at startup.

                      
	
                    Add Paper 
                    Size ANSI C/D/E

                      
	
                    Improve 
                    some of the interfaces

                      


                    

                    
                    Here are the new functions added to PDFill 
                    6.0.0.4: 

                    
                    1. PDFill PDF Editor:

                    	
                    
                    Print PDF Form Field's Name 
                    onto the saved PDF.

                      
	
                    
                    Add
                    AutoFill function for 
                    the PDF Form Filling.

                      
	
                    
                    Add a function to convert 
                    Image to Transparent Image.

                      


                    
                    2. PDFill FREE PDF and Image 
                    Writer: 

				    	
                    
                    
                    
                    PDF Optimization: Create PDF files optimized 
                    for Screen, Ebook (online uses), Printer, Prepress (high 
                    resolution and embedded fonts) or Default (wide variety of 
                    uses). 

                      
	
                    
                    
                    Post 
                    Process Options: Allow you to Email, Merge, Split 
                    or Reorder, Reformat, Header or Footer, Watermark after 
                    the PDF creation.

                      
	
                    
                    
                    PDF
                    Output Options: 
                    Allow you to Use Print Job Name under Default Folder.

                      
	
                    
                    Remove "Microsoft Word -" from 
                    the Print Job Name.

                      
	
                    
                    Simplify the Saving Dialog 
                    GUI. 

                      


                    
                    3. PDFill FREE PDF Tools:
                    

				    	
                    
                    
                    PDF Merge: 
                    Fix a bug so that hundreds of PDF files can be merged now.

                      
	
                    
                    
                    PDF 
                    Rotate and Crop: Add Even or Odd Page to be rotated or 
                    cropped.

                      
	
                    
                    
                    Add a new free function

                      
	
                    
                    
                    to 
                    convert an image into a transparent PNG file.

                      


                     

                    
                    Here are the new functions added to PDFill 
                    6.0.01: 

                    
                    

                    1. Add Vista Support.

				    
                    2. Add 64 
                    Bit support for XP/2003/Vista.

                    
                    3. Redesign the
                    PDFill Option:

                    	
                    
                    4 organized and tabbed views:
                    General,
                    PDF Form,
                    Default Value,
                    System.

                      
	
                    
                    Add  the 
                    version and installed folder for Sun Java, GhostScript, 
                    Adobe Reader.

                      
	
                    
                    Fix the 
                    Java Memory Error for the PDF with the extra big size by increasing Memory Size 
                    for Java. 
                    

                      
	
                    
            		Text and Image Alpha Bits 
                    are used to improve the 
                    quality of image inside PDFill when the PDF is converted 
                    into images. 

                      
	
                    
                    Add 
									Open Folder Automatically after 
                    saving PDF.

                      
	
                    
                    Add option 
                    for Page Display Style: Blue 
                    Gradient Style, Adobe Reader Style, Microsoft Office Style

                      
	
                    
                    Add option 
                    to Always scan into a new blank PDF

                      
	
                    
                    Add option 
                    to Show Font Warning when Comment Text 
            is used

                      
	
                    
                    Add option 
                    to Check Box's 
                                    Default Shape

                      
	
                    
                    Add option 
                    to 
									Show 
                                    warning if NO PDF Form Field

                      
	
                    
                    Add option 
                    to Hide 
                    Whiteout's Property Dialog

                      
	
                    Add option 
                    to Hide Highlight's Property Dialog and the default 
            Transparency for the highlight.


                    
                    4. Redesign the
                    PDF Saving Options:
                    

                      	
                    
                    6 organized and tabbed 
                    views:
                    Output options,
                    Description,
                    Encrypt/Decrypt,
                    View preferences,
                    Presentation Effect 
                    and
                    Rotate/Crop.
                    

                        
	
                    
                    Inside each tabbed view, a 
                    check is added to decide to use these options or not.

                        
	
                    
                    Add
                    
                    Presentation Effect:
                    
                    Set Page display duration, 
                    type and duration of the transition effect when displaying a 
                    PDF document as a presentation?or slide show.?/font>

                        
	
                    
                    Add Rotate and Crop:  PDF Page Rotation by 0/90/180/270? 
                    Crop box 
                    with margins...

                        


				    
                    5. New 
                    totally redesigned  FREE PDFill PDF Writer:  
                    Add new GUI and  new functions: 
                     PDF Description,  PDF Security, 
                    PDF View Preference, 
                     PDF Presentation, PDF Page's 
                    Rotate and Crop,  Output 
                    Options and Registry Control

				    
                    7. Add a New FREE Product:
		
                        
                        
                        FREE PDFill Image Writer:  Print your document into
                        PNG,  
                        JPG,  
                        BMP,
                        TIF and
                        GIF 
                        image file with options of  Resolution, Alpha Bits, Rotation or Flip,
                          
                         Output Options and Registry Control...

				    
                    8. Add 
                    Bookmark Support: 
                    No Action,
                    Go to a Local Page,
                    Go to another PDF,
                    Open a Web Link,
                    Launch a Document

				    
                    9.  
                    Open or 
                    
                    
                    save File Dialog with 
                    Explorer-style dialog boxes include a places bar containing 
                    icons for commonly-used folders, such as Favorites and 
                    Desktop.

                    
				    
                    10. Save the Last working folder and it will be used for 
                    next time to open file.

				    
                    11. New Tab Order from First Click:
                    Only the fields with bigger tab order than that of the first 
                    clicked field can be changed.

				    
                    12. 
                        
                        
                    
                    Convert the
                    Commenting Text into the
                    Multiple Line Text 
                        so that the text inside PDFill will match the text 
                        inside the PDF output. 

                    
				    
                    13. When a 
                    Check box is selected, Press Spacebar to check or uncheck.

				    
                    14. Added 
                    Rotated Single Line Text, Multiple Line Text, Image, 
                    Rectangular and Circle. The way to rotate an object is the 
                    same as the way inside Microsoft Office. 

				    
                    15. The function to export the form values as 
                    text or excel files becomes free for all the evaluation 
                    users.

				    
                    16. Press 
                    Esc to enter the Selection State. Also exit the Multiple 
                    Selection and Tab Order.

				    
                    17. 
                    Inserting the multiple copies of the same image will take 
                    only one image space inside PDF.

				    
                     

		
                    Here are the new functions added to PDFill 
                    5.0:

				    
                    1. New 
                    Installation Using Advanced Installer; Added Windows Vista 
                    Support

                    

                    
                    
                    
                    
                    2. Improved
                    PDF Form Maker: Create new PDF form 
                    fields to support the filling for all the 
                    international languages (English, German, French, Spanish, 
    Italian, Swedish, Central European, Cyrillic, Latin I, Greek, Turkish, 
    Hebrew, Arabic, Baltic, Vietnamese, Thai, Japanese, Chinese, and Korean).

				    
                    3. Add 
                    Drawing Functions: Line, Arrow, Rectangle, Circle, 
                    Arc, Pie; You can select line color, width, style, Fill, 
                    arrow style in the way similar to Microsoft Office.

                    

                    4. Add 
                    
                    PDF 
                    Commenting: 
                    Text Box Tool or
                    Highlight Tool,
                    Sticky Note Tool,
                    Popup Tool, 
                    File Attachment Tool, 
                    Play Video Tool, 
                    Line or Arrow Tool, 
                    Rectangle or Circle Tool

				    
				    
                    5. Export/Import using Excel Table and Adobe FDF  

				    
				    
                    6. 
                    Add PDF Actions: 

				      
				      
                        	Open A Web Link; 


                    
                          	Reset a PDF Form; 
	Submit the Form;
	Named Action (First Page, Next Page, Previous Page, 
                          Last Page and Print Dialog) 
	Go to Local Page (Local Page Number, Position, Zoom 
                          Factor)
	Go to Anther PDF (Page Number; Another PDF Path Name);
	Launch Application and Document


                    

                    
				    
                    7. 
                    DOS Command Support: You can start a batch job in Windows by 
                    issuing the execution command directly from the MS-DOS 
                    command prompt window without opening the PDFill GUI. (It is 
                    only available for the registered user)

                    

                           
                    7.1. 
                    Import a tab-delimited text file into a PDF Form

       "C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    IMPORT TXT Input.txt Input.pdf Output.pdf

                    

       7.2. Import a Excel table with Table Name "FORMDATA" 
                    into a PDF form

       "C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    IMPORT XLS FORMDATA  Input.xls Input.pdf Output.pdf

                    

       7.3. Import FDF into a PDF form

       "C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    IMPORT FDF Input.fdf Input.pdf Output.pdf

                    

       7.4. Merge PDFs into a new PDF

       "C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    MERGE Input1.pdf Input2.pdf Input3.pdf Output.pdf

                    

       7.5. Split a PDF into a new PDF according 
                    to page number selection

       "C:\Program Files\PlotSoft\PDFill\PDFill.exe" 
                    SPLIT "1,3-6,10,13,24" Input.pdf Output.pdf 

				    
				    
                    8. Copy 
                    Edited Object from another PDFill Project File.

				    	
                     Copy 
                      SingleLine / MultiLine Texts, Check Mark and Image


                    
                      	Copy 
                      New Added Form Fields
	Copy 
                      Original Form Fileds and Convert into Editable Fields
	Copy 
                      Original Form Fields Value Only


                    
				    
                    9. Add PDF Scanner 
                    to convert paper into PDF

				    
                    10. Improved PDFill 
                    Filler

		
                     

				    
                    Here are the new functions added to PDFill 
                    4.1 Beta:

				    1. "PDFill 
                    Form Filler 4.0" will be renamed as "PDFill PDF 
                    Editor 4.1" since we are adding more and more PDF 
                    editing functions. 

                    2. New 
                      professional modern appearance similar to many popular 
                      Microsoft'a products.	Add Toolbar icons into the corresponding Menu Items.


                    
                      	Menu 
                      and Toolbar Themes:  Microsoft Office XP, Office 
                      2003, Office 2000, Native XP or Visual Studio 2005.
	New 
                      intelligent menus: The user presses or hovers over the 
                      chevron-style button to completely expand the menus.
	Add 
                      and remove toolbar commands dynamically, ensuring that 
                      users have all of the toolbar commands needed, and none 
                      that are not wanted. 
	Save 
                      the current state of your toolbar and menus in plus any 
                      customization made.


                    
                    
                    3. Scan 
                    your Paper Form or Image directly into a new or existing PDF 
                    document, then you can fill it using computer!

                    

                    4. Add a toolbar button to the Microsoft Internet Explorer 
                    user interface. Click that button and PDF file inside the 
                    browser will be sent into PDFill.

                    5. Drag 
                    and drop files (PFL, PDF and Images) into PDFill.

                    6. Add 
                    Encode options in the Format Toolbar.

                    7. Add 
                    Printing Option inside PDF Saving so that the Original PDF 
                    page will  be hided and the new edited information will 
                    be printed into the pre-printed form.

				    
                    8. add 
                    Panning the view by dragging the left mouse.

				    
                    9. 
                    Multiple Object Selection for Delete, Copy and Move by 
                    offset in X and Y; Move one pixel left, right, up and down.

				    
                    10. 
                    Support the most updated GhostScript 8.53.

				    
                    11. 
                    Export/Import Form Data into TAB delimited text Text, 
                    Microsoft Excel, or CSV File. 

				    
                    12. Add 
                    Form Action and JavaScript for Text, Check, Radio, Combo, 
                    List Field. It is now feasible to add simple calculation 
                    inside the form fields by JavaScript.

				    
                    13. Add 
                    New Form Field's Border Color, Border Size and Border Style.

				    
                    14. Use 
                    Adobe Font for new text objects when the filled PDF is 
                    saved.

				    
                    15.
                    
                    Replace some font name by 
                    another font name.

				    
                    16. PDFill 
                    Options: Show
                    Form Field's Name, 
                    Default Font Name is selected from most often used Font 
                    Name.

				    
                    17. FREE 
                    PDF Tools-PDF Rotate/Crop: Add Options for Landscape or 
                    Portrait page Only.

				    
                    18. FREE 
                    PDF Tools-PDF Merge: Concatenates PDF documents including 
                    form fields. The rules for the form field concatenation are 
                    the same as in Acrobat. 

				    
                    19. A few 
                    Bugs were fixed after the 4.0 was released.

                    
                    Here are the new functions added to PDFill 
                    4.0: (Updated 
                    August 6, 
                    2005)!

                    
                    1. Type text in almost any international 
                    language into PDF

                    
                    2. Support All True Type Fonts in Windows

                    
                    3. Read/Create Combo/List PDF Form Field
                    

                    
                    4.
                    Read/Create  multiple form fields with 
                    the same form field name across different pages

                    
                    5. 
                    Create Push Button Form Field: Open an URL/Email 
                    Link, Reset PDF Form, Submit PDF Form to your web server for 
                    database, Run JavaScript.

                    
                    6. Tab Order Editing 
                    by Click or Table

                    
                    7. 
                    Flatten PDF Form Fields

                    
                    8. 
                    Insert URL, Whiteout, and Highlight easier

                    
                    9. 
                    Text Editor is easier to use: Click the inside to edit;  
                    Click the edge shadow to move or delete; Move object by 
                    arrows

                    
                    10. 
                    Adjust the form field height using Font size;  Make 
                    check or radio box square 
                    
                    
                    
                    

                    
                    11. Set the current object as Default 

                    
                    12. Option to hide the editing function to 
                    make interface simpler: the user can only fill and save

                    
                    13.
                                      
                                      Align Tool to
                                      precisely align 
                                      Left, Horizontal Middle, Right, Top, 
                                      Vertical Center, Bottom, Space Evenly 
                                      Across/Down, Make Same Width or Height

                    
                    14. Print 
                    the filling PDF to the default printer directly

                    
                    15. Email 
                    the filled PDF as an attachment

                    
                    16. Free PDF Tools: List, Delete and Flatten 
                    the PDF form Fields

                    
                    17. Free PDF Tools: Convert Postscript into PDF.

                    
                    18. Free 
                    PDF Writer upgrade.

                    Please 
                    send your question and suggestion to
                    
                    
                    support@PDFill.com. Thank you for your help.
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